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Velkommen til ZoomText 9.1

ZoomText 9.1 er et specialdesignet computer program der hjeelper svagsynede med at
se skaermbilledet pa computeren. Ved at benytte bade skeermforstorrelse og
skeermlaesning giver ZoomText mulighed for bade forstorrelse til den storrelse man
har brug for og hejtleesning af teksten pa skeermen, herunder menuer, dokumenter,
email og Internet.

ZoomText 9.1 fas i to versioner:

Magnifier — kun skeermforstorrelse
Magnifier/ScreenReader — skeermforsterrelse og skeermlaesning

Denne kortvejledning giver et hurtigt overblik over installation og brugen af
ZoomText funktionerne i begge versioner.

De funktioner der henviser til hojtleesning med syntetisk tale kan kun bruges hvis man
har ZoomText Magnifier/ScreenReader versionen.

Bemark: Denne vejledning beskriver ikke alle funktionerne i ZoomText 9.1 og
erstatter derfor ikke den fulde manual. Der henvises til ZoomText
Brugervejledningen eller hjeelpesystemet for yderligere information. Start
online hjeelpen ved at veelge Hjeelp » ZoomText Hjeelp i ZoomText
menulinien.
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Systemkrav

ZoomText 9.1 kreaever folgende af computeren:

e 450 MHz Pentium ® III processor eller tilsvarende
1.5 GHz for Windows Vista

o Et af folgende styresystemer:
Windows Vista
Windows XP
Windows 2000

e Internet Explorer 5.0 eller senere

e Minimum 256 MB RAM
Minimum 1 GB er nedvendigt for Windows Vista

e Minimum 25 MB fri plads pa harddisken
(ekstra 60 MB for hver NeoSpeech syntese)

e Lydkort (kun nedvendig til Magnifier/ScreenReader versionen)
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Installation af ZoomText

Nar ZoomText CD seettes i CD-ROM drevet starter Setup automatisk op. Folg
instruktionerne pa skeermen for at installere ZoomText.

» Hvis Setup ikke starter automatisk

1. Klik pa Start knappen (eller tryk pa tastaturets Windows tast) og veelg Kar....
2. Skift til CD-ROM drevet.

3. Skriv SETUP.

4. Klik pa OK knappen.

» Afinstallation af ZoomText

1. Serg for at ZoomText ikke er startet.
2. Veelg Afinstaller ZoomText 9.1 fra ZoomText 9.1 mappen i Startmenuen.
3. Folg instruktionerne pa skeermen.

Installation af ZoomText pa Windows Vista, XP eller 2000

Idet ZoomText laegger nogle systemfiler ind pa Windows Vista, XP og 2000 er det

ngdvendigt at have administrator rettigheder under installationen. Hvis man ikke
har disse rettigheder skal man kontakte sin netveerksadministrator for at installere
programmet.
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Aktivering af ZoomText

ZoomText 9.1 har indbygget en produktaktivering for at undga piratkopiering.
produktaktiveringen er enkel og annonym og tager kun nogle fa sekunder nar man
anvender Internet til det.

ZoomText virker i 60 dage unden aktivering idet den virker som demoversion. Man
kan veelge at aktivere sit program nar som helst indenfor de forste 60 dage. I
demoperioden virker programmet fuldt ud med alle funktioner. Nar demoperioden er
udlebet skal man aktivere programmet for fortsat at anvende ZoomText.

Preparing to Activate ZoomText

For at aktivere ZoomText 9.1 har man brug for ZoomText 9.1 serienummeret, som er
leveret med produktpakken. Hvis der er tale om en ZoomText 9.1 opgradering har
man ogsa brug for det serienummer som man vil opgradere fra. (version 9.0 eller
tidligere), memindre den allerede er installeret pa computeren.
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Activating ZoomText (fortsat)

Under 60-dages demoperioden vil ZoomText aktiverings guiden vises hver gang
ZoomText startes. Guiden giver folgende muligheder:

e Mulighed 1: Jeg har et serienummer og ensker at aktivere ZoomText

Velg denne mulighed hvis ZoomText allerede er kobt ogZoomText skal
aktiveres nu. Guiden vil hjeelpe med at fa ZoomText aktiveret.

e Mulighed 2: Jeg onsker at kebe ZoomText

Velg denne mulighed hvis ZoomText skal kagbes. Guiden vil hjelpe med
information om hvordan man kan bestille ZoomText.

e Mulighed 3: Jeg onsker at prove ZoomText

Velg denne mulighed hvis ZoomText skal virke som demo. I demotilstand
virker Zoomtext i 60 dage. Nar demoperioden er udlebet skal ZoomText
aktiveres for fortsat at kunne anvendes.

For yderligere information om aktivering af ZoomText se “Aktiver ZoomText 9.1” i
ZoomText Brugervejledningen eller hjeelpesystemet.
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Start ZoomText

Nar ZoomText er installeret pd computeren kan det startes pa en af folgende mader.

e Klik pa ZoomText 9.1 ikonen pa skrivebordet.

e Velg ZoomText 9.1 programmet fra ZoomText 9.1 mappen.

Nar ZoomText starter vil skeermen blive forsterre. Nar musen eller markoren bevaeges
rundt pa skaermen eller dialogbokse abnes vil det aktive element altid blive vist pa den
forsterrede skaerm.

Hvis man har installeret ZoomText Magnifier/ScreenReader vil der ogsa veere
talesyntese som stotte, som kan leese al tekst pa skeermen hejt. Bemaerk dog at den
indbyggede tale ikke findes pa dansk. Dansk tale kabes separat. Alle Windows
programmer vil virke normalt mens ZoomText er aktiv.

» Afslut ZoomText

Velg Afslut fra Filer menuen.
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ZoomText Brugerfladen

Nar ZoomText startes vises brugerfladen pa skeermen. Dette vindue giver adgang til
alle funktioner I ZoomText. De funktioner, der kun virker med tale er lagt ind i
separate veerktgjslinier og dialogbokse.

E ZoomText 9.1

Filer  Akkivieet Forstéirrelse  Laeser  Indstllinger

Q Forstarrelse | gl Lesser

Laeser fanen
Viser veerktgijslinien med ZoomText
skaermlaesning funktionerne.

Forstgrrelse fanen
Viser veerktgijslinien med ZoomText
forstgrrelse funktionerne.

Minimer knap
Skjuler ZoomText
brugerfladen.

Hjzelpevaerktgj

Zoomyinduer Fremhazvninger Sgger Viser h]&|p til det
L = = der klikkes pa.
2 3 @ K X @ & &
FoomText Fakbor Type Fatwve Mus Markgr F Skrivebord  ‘Web Tekst
Program: Jnkernet Explorer | Laesere
— ZoomText knap Statuslinie _ ,
Aktiverer eller Viser navnet pd det aktive program og angiver hvorndr man
deaktiverer ZoomText. kan anvende AppReader og DocReader ("Laesere"), laesezoner
("Zoner") og program indstillingerne ("App Indstillinger".
8
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ZoomText Brugerfladen (fortsat)

ZoomText brugerfladen kan minimeres (skjult) og gendannet (gjort synlig) uden det
pavirker maden ZoomText virker pa.
> For at minimere ZoomText

Brug en af disse metoder:

e Pa ZoomText, klik pa minimer knappen.

e Tryk pa ESC nar ZoomText brugerfladen er aktiv.

» For at gendanne ZoomText
Brug en af disse metoder:
e Klik pa ZoomText 9.1 knappen i ZoomText brugerfladen.
e Brug Vis brugerflade genvejen: CTRL + SKIFT + U.
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Aktiver og deaktiver ZoomText

Nar ZoomText korer pa computeren vil skeermen automatisk blive forstorret og
teksten leest hgjt. Man kan deaktivere ZoomText pa et vilkarligt tidspunkt uden at
afslutte andre programmer. Nar ZoomText er deaktiveret vises normalskeermen (uden
forsterrelse) og al tale gennem ZoomText stoppes.
> For at aktivere ZoomText

Brug en af disse metoder:

e Klik pa ZoomText knappen i brugerfladen.

e Brug Aktiver ZoomText genvejen: ALT + INSERT.

> For at deaktivere ZoomText
Brug en af disse metoder:

e Klik pa ZoomText knappen i brugerfladen.
e Brug Deaktiver ZoomText genvejen: ALT + DELETE.
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Forstorrelse Vaerktojslinien

Forstorrelse veerktojslinien giver hurtig adgang til ZoomText forsterrelsesfunktioner.
Hver knap pa veerktgjslinien er udstyret med et symbol der viser funktionens
egenskab. Mange af disse knapper har ogsa pop-op menuer der giver hurtig adgang til
de vigtigste indstillinger i forbindelse med funktionen. Knapper der hore sammen er
grupperet under en overskrift som kan benyttes som genvej til den tilherende
dialogboks. Funktionerne i veerktgjslinien er beskrevet naermere pa siderne 11 til 32.

Ikon

Gruppe navn

{:{ Forstgrrelse
Zoomvindusr Fremhaevninger Sgaer
s 'T— =
— [="]
> 5 @ K I @ @ R
Fakkor Tvpe Farve MUz Marlgr Fokus Skrivebord  web Tekst

Gruppe

Ikon navn
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Indstil forstorrelsen

ZoomText giver mulighed for at forsterre skeermbilledet i en reekke niveauer hvorved
man kan opna den mest optimale forstoerrelse. Forstorrelsen kan indstilles mellem 1
gang og 36 gange (mellem 1 og 81 trin pa 1, mellem 10 og 16 i trin pa 2, mellem 20 og
36 i trin pa 4 samt forsterrelserne 1,25, 1,5, 1,75 og 2,5 gange).

» For at justere forstgrrelsen

«  Velgniveauet i Forstorrelse veerktojsliniens Faktor boks,
‘ 2 + eller brug forstoerrelse genvejene:

Faktar
For at fa... Tryk...
Mere forstgrrelse ALT + NUMPAD PLUS
Mindre forstgrrelse ALT + NUMPAD MINUS

]

2 Printers and Faes

@ Help and Suppart
- search

All Programs D ek Dal Solution Center

1 gang (normal skeerm) 3 gange
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Valg af Zoomvindue

ZoomText giver mulighed for at veelge mellem otte forskellige zoomvinduer:
Helskaerm, Overliggende, Lup, Linie og fire Laste vinduer. Hvert vindue har sin
seerlige made at vise det forsterrede skeermbillede. Man kan skifte mellem vinduerne
nar der er behov for det.

» For at veelge zoomvindue

= Velg Type pa Forstorrelse veerktojslinien og veelg det enskede

- zoomvindue.

Type Man kan ogsa skifte mellem de mulige zoomvinduer ved at bruge
Zoomvindue genvejen: CTRL + SKIFT + Z.
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Valg af Zoomvindue (fortsat)

Zoomvindue Typer
Helskarm viser hele skaermen i forsterret tilstand. -
Helskaerm
Overliggende viser forstorrelsen pa en del af skeermen. Dette =
zoomvindue kan justeres i storrelse og position. ==
Overliggende

Lup flytter forsterrelsen med rundt pa skeermen, der hvor markeren =

: : b
eller det aktive element findes.

Lens
Linie er et vandret vindue som kan flyttes op og ned pa skeermen, =—
hvor den viser det der ligger lige under zoomvinduet. Linie
zoomvinduet folger automatisk musen, tekstmarkeren og fokus i Linie
programfladen i gvrigt.
Last deler skeermen op i to dele, hvor den forsterrede del — —.
er last til den ene kant af skeermen, og den anden viser — —
normalskeermen (uden forsterrelse). Top Bund
Venstre Hojre
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Justering af Zoomvindue

ZoomText vinduerne kan justeres i storrelse og position pa skeermen (undtaget
helskeerm zoomvinduet, der fylder hele skaermen ud).

» For at justere et zoomvindue

1. I Forsterrelse verktgjslinien veelges Type » Juster.
Justeringshdndtag (smd kasser) vises i hjornerne af rammen pd zoomvinduet.
2. Treekiet af handtagene for at justere storrelsen.
Tag fat indenfor vinduets ramme og traek for at flytte vinduet.
4. Hold CTRL nede mens der treekkes indenfor vinduets ramme for at rulle
indholdet i vinduet.
5. Tryk pa ESC for at afslutte vindueveerktgjet.

w
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Brug af Holdvindue

Holdvindue giver mulighed for at laese information fra en del af normalskeermen
mens der redigeres i tekst et andet sted. Holdvindue ligger oven pa Helskaerm vinduet
og viser den gnskede del af normalskeermen.

» For at indstille et holdvindue

1. Velg Helskeerm zoomvinduet.

2. Velg Hold » Ny pa Forsterrelse veerktgjslinien.

3. Flyt musen for at rulle til det gnskede sted pa skaermen.

4. Treek et omrade ud for at veelge Hold-omradet.
Holdvinduer vises med justeringshdndtag pa rammen.

5. Treek i handtagene for at justere storrelsen. Tag fat indenfor vinduets ramme og
treek for at flytte vinduet. Hold CTRL nede mens der traeekkes indenfor vinduets
ramme for at rulle indholdet.

6. Hojreklik for at afslutte vinduevaerktgjet eller tryk pa ESC.

» For at aktivere eller deaktivere Holdvindue

Pa Forstorrelse veerktgjslinien veelges Type » Hold » Aktiver
(eller Type » Hold » Deaktiver).
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Brug af Feltvisning

Feltvisningen viser det omrade pa normalskeermen som forsterres, og giver mulighed
for at veelge et nyt omrade der skal forstorres. Forstorrelsen slukker nar Feltvisningen
er aktiveret og der vises en sgger pa normalskeermen. Ved at flytte sogeren kan man

veelge et nyt omrade der skal forsterres.

» For at benytte feltvisning

1. Velg Feltvisning fra Aktivitet menuen.
Forstorrelsen slukker og sogeren vises.

2. Flyt sogeren til den enskede position.

3. Kilik for at zoome ind pa den nye position.
Forstorrelsen aktiveres med det valgte omrdde vist.

Man kan veelge mellem forskellige former og farver som zoomfelt sogeren vises med.
Feltsogeren kan ogsa veelges til at vise en normalskaerm nar der samtidig bruges et

Overliggende eller Last zoomvindue.

» For at justere Feltsggeren

1. Velg Feltsoger... fra Forstorrelse menuen.
2. Velg de gnskede indvstillinger.
3. Veelg OK knappen.
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Understottelse af Ekstra Skaerm

Nar der anvendes en computer, forsynet med to skeerme, giver ZoomText's
understottelse af Ekstra Skeerm dig mulighed for at anvende de primeere og
sekundeere skeaerme til at fordoble bredden af forsterrelsesvisningen (Primeert
Udvidet), til at duplikere forsterrelsesvisningen (Primeer Kopi), eller samtidigt vise en
forsterret og en ikke forsterret visning af skeermen (Primeer med 1x). ZoomText's
visning pa to skaerme er designet til at forbedre produktivitet og gor det behageligt for
individuelle brugere (som arbejder alene) eller en gruppe af brugere (svagtsseende og
normalt seende), som arbejder sammen pa samme system.

Krav til system med Ekstra Skaerm
For at kunne anvende ZoomText's understottelse af Ekstra Skeerm skal dit system have
tolgende hardware og software:

e Windows Vista eller Windows X

e En desktop eller laptop computer forsynet med et videokort med to udgange,
eller med to videokort

e To computer skeerme (enhver kombination af CRT eller LCD)

Notat: For den bedste visning i Primeert omrade visning anbefaler vi at anvende
ensartede LCD skeerme (storrelsesmaessigt), placeret umiddelbart ved siden af
hinanden. Denne konfiguration giver en forsterrelsesvisning, som er pa linie
med hinanden.
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1derstottelse af Ekstra Skaerm (fortsat)

Primert omrade udvider ZoomText's forsterrelsesvisning
hen over den primeere og sekundeere monitor, sd maengden
af information, der kan ses pa en gang, fordobles. Med
visning af den dobbelte information kan du arbejde
hurtigere og mere behageligt, end det er muligt pa en
enkelt skaerm.

Primaer Kopi viser den samme forsterrelsesvisning pa din
primeere og sekundeere skeerm. Denne tilstand er nyttig,
nar to eller flere brugere skal se det samme billede, men
ikke er placeret, sa de kan dele den samme skeerm.

Primar med 1x viser en forsterret visning pa din primeere
skeerm, og en ikke forsterret visning pa din sekundeere
skeerm. Denne tilstand er nyttig, nar en svagtsynsbruger og
en normalt seende bruger arbejder sammen pa det samme
system. Svagtsynsbrugeren kan zoom'e ind til det enskede
niveau (pa den primeere skaerm), men den normalt seende
bruger kan se det ikke forsterrede billede pa den

sekundeere skeerm.
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Understottelse af Ekstra Skaerm (fort:

Den forste gang, du starter ZoomText, vil den automatisk finde ud af, om der er to
skeerme pa dit system, og sperge dig, om du onsker at aktivere Ekstra Skeerm
funktionen. Hvis du svarer 'Ja', vil ZoomText aktivere Ekstra Skeerm funktionen i
Primeert omrade visning (standard). Men du kan til enhver tid aktivere eller
deaktivere Ekstra Skeerm funktionen, eller veelge en anden visning pa de to skeerme.

» For at aktivere eller deaktivere Ekstra Skaerm funktionen

— Pa Forstorrelse veerktojslinien veelg Type » Ekstra Skeerm » Aktivér

Ili (eller Deaktivér), eller tryk Ekstra Skeerm Til/Fra genvejen:
Tvpe WINDOWS + SKIFT + D.

» For at vaelge en visning for Ekstra Skaerm

— P& Forsterrelse veerktgjslinien veelg Type » Ekstra Skeerm, og veelg
II- derneest den onskede visning for Ekstra Skeerm.

Type Du kan ogsa lobe igennem Ekstra Skeerm visninger ved at trykke
genvejen for Ekstra Skeerm visning: WINDOWS + SKIFT + Z.
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Farvefremhaevning

Farvefremheevningen oger leesbarheden af tekst og grafik pa skeermen.
Farvefremhaevningen giver mulighed for at vaelge mellem en lang raekke farveeffekter,
kontrast og lyshed justeringer. Man kan veaelge fra preedefinerede temaer eller oprette
en speciel.

» For at veelge et tema
(b Velg Farve » Tema og velg det onskede tema.

Farwe

» For at oprette et specielle farvesammensaetninger

1. Veelg Farve fremhaver... fra Forstorrelse menuen.
2. Velg Speciel...

3. Juster som gnsket.

4. Velg OK knappen.

Bemark: Man kan teende og slukke for farvefremheevningen ved at bruge genvejen:
CTRL + SKIFT + C.
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Musmarkor fremhaevning

Markerfremheevningen gor det lettere at finde og bruge musen pa skeermen. Man kan
justere storrelse og farve pa musen, samt aktivere en soger der fremheever musens
position pa skeermen. Man kan veelge fra preedefinerede temaer eller oprette en

speciel.
» For at veelge et tema
[% Velg Mus fremhaver » Tema og velg det onskede tema.

Mus

» For at oprette et specielle musindstillinger

1. Velg Mus fremhaver... fra Forstorrelse menuen.
2. Velg Speciel...

3. Juster som @nsket.

4. Velg OK knappen.

Bemark: Man kan bruge genvejen til at teende eller slukke for musmarker
fremheeveren: CTRL + SKIFT + P.
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Tekstmarkor fremhasvning

Tekstmarkerfremhaevninger gor det lettere at finde tekstmarkeren. Man kan veelge
mellem en reekke af sogere som oger markerens visning uden at blokere for teksten.
Man kan veelge fra preedefinerede temaer eller oprette en speciel.

» For at vaelge et tema
I Vealg Marker fremhaver » Tema og veelg det onskede tema.

Markgr

» For at oprette et specielle markgrindstillinger

1. Velg Marker fremhaver... fra Forsterrelse menuen.
2. Velg Speciel...

3. Juster som gnsket.

4. Velg OK knappen.

Bemark: Man kan teende og slukke for markerfremhaeveren ved at bruge genvejen:
CTRL + SKIFT + R.
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Fokus Forbedringer

Fokus forbedringer gor det nemmere at finde og felge fokus kontrollen, nar du bruger
tab eller piletasterne til at flytte igennem menuer, dialoger, veerktgjslinier og andre
programkontroller. Nar den er aktiveret, viser en forvalgt hejt synligt sager positionen
af fokus kontrollen uden at skjule en eventuel underliggende tekst. Du kan veelge fra
foruddefinerede fokustemaer, eller selv konfigurere dine egne fokus indstillinger.

» For at veelge et foruddefineret markegr tema

=1 Velg pa Forsterrelse veerktgjslinien Fokus » Tema, og velg dernaest
=] det onskede fokus tema.

=]
Fokus

» For at konfigurere bruger markgr indstillinger

1. IForsterrelse menu veelg Fokus Forbedringer...
2. Velg Speciel...

3. Juster brugerindstillingerne, som ensket.

4. Klik pa OK knappen.

Notat: Du kan sla Fokus Forbedringer til og fra ved brug af Fokus Forbedringer
Til/Fra genvejen: CTRL + SKIFT + O.
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Tekst fremhaever

Med de traditionelle skeermforstorrelsesprogrammer vil teksten, nar den bliver
forstorret, forsteerke de prikker skeermen er opbygget af, med deraf folgende nedsat
billedemaessig tekstkvalitet. Problemet er specielt stort med seerlige skrifttyper f.eks.
sma skrifttyper, serif og kursiv tekst. Den nye teknik kaldet XFont, som er specielt
udviklet til ZoomText, loser dette problem.

Med xFont vil alle skrifttyper blive vist i perfekt kvalitet, selv i den ekstreme store
forstorrelse (36 gange). Man har ogsa mulighed for at at tilpasse visningen af XFonten
ved brug af Udglat, Fed og Kompakt funktionerne. Udglat funktionen sorger for at
kanterne pa skrifttyperne udglattes. Funktionen Fed oger stregtykkelsen pa
bogstaverne. Funktionen Kompakt oger afstanden mellem bogstaverne/linierne.

Hvis computeren er for langsom til at anvende xFont kan man skifte til indstillingen
Standard, hvorved en mellemkvalitet pa skeermforbedringen opndes.
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Tekstfremheaever (fortsat)

» For at skifte Tekst fremhaever type

Press the Tekst fremhaver genvejen: CTRL + SKIFT + F. Trykker man gentagne
gange pa genvejen skifter tilstanden mellem de tre mulige: xFont, Standard og
Ingen.

» For at justere tekstfremhaevningen

1. IForsterrelse menuen veelges Tekst fremhaver...

2. Juster som ensket
3. Klik pa OK knappen.
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Skrivebordssogeren

Skrivebordssageren hjeelper med at finde abne programmer og dokumenter, samt
programmer fra hurtig startmenuer, systembakken og kontrolpanelet. Nar
Skrivebordssggeren startes vises en dialogboks med en liste over hvilke programmer
der er dbne. Denne liste man reduceres ved brug af filtre og man kan sgge i den, sa
man hurtigt kan finde det enskede program. Man kan bade skifte til det gnskede
program og se egenskaber for det direkte fra skrivebordssegeren.

» For at bruge Skrivebordssggeren
E 1. Veelg Skrivebord veerktgjet fra Forsterrelse veerktgjslinien.

Skrivebordssogeren dialogboksen vises.

Skrivebord 2. Filtrer eller sorter listen ved at bruge den enskede funktion i Vis
disse emner og Sorter emner efter.

3. For at begraense sogningen kan man skrive den information der
sages i Seg komboboksen eller man kan veelge sggeord der
tidligere er brugt.

4. Marker det onskede program i listen.

5. Klik pa Aben knappen for at skifte til programmet. Klik pa
Egenskaber knappen for at fa vist egenskaberne for det valgte
program.
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Web soger

Med Web sggeren finder man hurtigt link i HTML tekst pa Internet, i email og i
hjeelpefiler. Nar Web sggeren startes vises en dialogboks med en liste over alle link i
det sidst aktive HTML dokument. Nar Web sogeren startes vises en dialogboks med
en liste over alle link i det sidst aktive HTML dokument. Denne liste kan filtreres og
sorteres efter behov. Man kan aktivere link, rulle hen til et link og leese fra
linkplaceringen i teksten ved brug af AppReader.

» For at bruge Web sggeren

1. Velg Web fra Forstorrelse veerktgjslinien.
@ Web soger dialogboksen vises.
Weh 2. Filtrer eller sorter listen ved at bruge den gnskede funktion i Vis
disse emner og Sorter emner efter.

3. For at begraense sogningen kan man skrive den information der
sages i Seg komboboksen eller man kan veelge sggeord der
tidligere er brugt.

4. Marker det onskede link i listen.

5. Klik pa Felg Link knappen for at dbne den nye side. Klik p&d Rul
til knappen for at flytte til link teksten. Klik pa Laes fra knappen
for at leese fra linkets placering i teksten (leesningen sker ved brug
af AppReader).
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Brug af Tekstsogeren

Tekstsogeren hjeelper til at finde ord eller tekst indenfor det program der er i brug eller
pa hele skeermen. Efter den onskede tekst er skrevet finder og markere Tekstsggeren
mens den laeses.

» Brug af Tekstsggeren
% 1. IForsterrelse veerktgjslinien veelges Tekst.

Tekstsoger dialogboksen vises. For mere information om denne se
Texk "Tekstsoger indstillinger” i dette kapitel.
2. ISeg boksen skrives det eller de ord der skal soges.
Veelg Tekstsoger indstilingerne.
4. Klik pa Seg knappen.
Tekstsoger dialogboksen skjules og forste forekomst af teksten markeres pi
skeermen og leeses. Tekstsoger vaerktojet vises over den fundne tekst
hvorfra man kan navigere eller laese 1 teksten.
5. For at navigere til naeste eller forrige forekomst benyttes

W

veerktgjslinien eller tilherende genveje.
6. Afslut Tesktsogeren ved at hgjreklikke eller trykke pa ESC.
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Brug af Tekstsogeren (fortsat)

Tekstsoger veerktgjslinien hvormed man kan navigere eller leese vises over den fundne

P M 7 E X

Tekstsoger vaerktojslinien

Las* Laeser hele teksten pa den linie hvori den fundne tekst star.
Genvej: ENTER

Forrige Viser forrige forekomst.
Genvej: LEFT or SKIFT + TAB

Naste Viser neeste forekomst.
Genvej: RIGHT eller TAB
Start AppReader * Starter AppReader starter opleeningen fra den markerede tekst.

Indstillinger Bringer Tekstsgger dialogboksen frem igen.
Genvej: BACKSPACE

Luk Lukker Tekstsogeren.
Genvej: ESC
* Denne mulighed findes ikke i ZoomText Magnifier.

XY T T ¢

3

)
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Glat panorering

Glat panorering (patentanmeldt) giver en mere naturlig panoreringsbevaegelse, nar
den forsterrede visning ruller for at fastholde fokus i visningen. Mens du skriver tekst
og navigerer menuer, dialoger og andre programkontroller, panorerer den forsterrede
visning glat hen over skeermen i stedet for at hoppe pa en brat médde. Du kan ogsa
anvende “glat mus panorering” til at panorere glat og udforske i enhver retning.

Notat: Glat mus panorering er kun muligt, ndr zoom vinduet er sat til Helskaerm.

» For at aktivere og justere glat panorering
1. IIndstillinger menuen velg Panorering...
2. Veer sikker pa, at Aktivér glat panonering boksen er valgt.
3. Justér indstillingerne for panorering som ensket.
4. Klik pa OK knappen.

Notat: Du kan sla glat panorering til og fra ved brug af Glat panorering Til/Fra
genvejen: WINDOWS + SHIFT + P.
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Glat panorering (fortsat)

» For at anvende glat mus panorering

1.
2.

Veer sikker pd, at zoom vinduet er sat til Helskaerm.

Tryk Glat mus panorering genvejen: CTRL + klik musehijul.
Mus panoreringsveerktojet bliver aktivt.

For at starte panorering flyttes musen i den retning, du ensker at panorere.

For at forgge eller formindske panoreringshastigheden flyttes musen veek fra
eller teettere pa centrum.

For at skifte panoreringsretning flyttes musen til en ny retning (relativt i forhold
til centrum).

For at stoppe panorering flyttes musen tilbage til centrum.

32

ZoomText 9.1 kortvejledning



Laeser Veerktojslinien

Leeser veerktojslinien giver let adgang til ZoomText talestotte.

Hver knap pa veerktgjslinien er udstyret med et symbol der viser funktionens
egenskab. Mange af disse knapper har ogsa pop-op menuer der giver hurtig adgang til
de vigtigste indstillinger i forbindelse med funktionen. Knapper der hore sammen er
grupperet under en overskrift som kan benyttes som genvej til den tilherende
dialogboks. Funktionerne i veerktgjslinien er beskrevet neermere pa siderne 33 til 54.

Ikon

Gruppe navn

@]9 Lasser
Tale Ekln Laesning
| A
50 .T ¢ 7
l,}) b} . @ L L L]
Tale Tempo Task 1T Detalje AppRdr DocRdr Zoner LazsDet

Gruppe

Ikon navn
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Start og stop talen

Man kan starte og stoppe talen uden af deaktivere forsterrelsen.

» For at aktivere eller deaktivere talen

- Velg Tale » Aktiver (eller Deaktiver) fra Laeser veerktgjslinien
ELLER brug Tale Til/fra genvejen: ALT + SKIFT + S

Tale

Bemark: AppReader, DocReader og LasDet kan bruges nar talen er deaktiveret.

Der kan veere tidspunkter hvor man ensker at stoppe talen. Eksempelvis nar
ZoomText laeser en dialogboks som man kender. Man kan stoppe talen uden at sla
opleesningen helt fra.

» For at stoppe igangvaerende tale
Tryk pa CTRL tasten og slip den igen.

Den igangveerende oplcesning stopper.
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Juster talehastigheden

Talehastigheden giver mulighed for at styre den fart teksten leeses med i ZoomText
(ord per minut for en SAPI 4 syntese, procent af maksimalt mulige for en SAPI 5
syntese).

» For at justere talehastigheden

2 Abner Leeser verktejslinien og juster Hastighed boksen,
‘ a0 ELLER brug Tale genvejene:

Tempao
For at... Tryk pa...
Fa stgrre talehastighed CTRL + NUMPAD PLUS
F& lavere talehastighed CTRL + NUMPAD MINUS

Man kan justere talehastigheden uafheengigt for AppReader og
DocReader. Disse indstillinger findes i Funktioner dialogboksen.
Veelg Lasning indstillinger... fra Leeser menuen.

Bemark: Der er flere justeringsmuligheder for talen. Disse findes ved at veelge
Tale... fra Leeser menuen.
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Tale indstillinger

Taleindstillingerne giver mulighed for at justere pa den talesyntese der benyttes til
opleesningen. Afheengig af talemotor (producent) kan man veelge forskellige stemmer,
og man kan indstille talehastigheden, stemmelejet og lydstyrken.

Bemark: ZoomText leveres med fire forskellige talesynteser: NeoSpeech (kun
engelsk), TruVoice, ViaVoice og Microsoft Speech. ZoomText
installationsprogrammet giver mulighed for at veelge frit mellem de
mulige synteser og sprog. ZoomText virker ogsa med andre SAPI 4 eller
SAPI 5 baserede talesynteser som skal installeres separat pa computeren.

» For at justere talen

1. Veelg Tale... fra Laeser menuen

2. Kontroller at Brug talesyntese er valgt.

3. Juster som @nsket.

4. For at preve indstillingen kan man skrive tekst i feltet Provetekst og klikke pa
Laes provetekst Sample.

5. Klik pa OK knappen.
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Tastatur ekko

Tastaturekko giver mulighed for at veaelge opleesning af tastetryk og ord mens man
skriver. De skrevne ord leeses sa snart der er afsluttet med et mellemrum eller et
punktueringstegn. Man kan yderligere veelge opleesning af tasterne som ikke er
alfabettaster.

» For at aktivere tastatur ekko

Klik pa Tastatur i Leeser veerktojslinien og veelg typen af tastatur

ekko.

Task

» For at justere Tastatur Ekko

1. Velg Tastatur Ekko... fra Laeser menuen.
2. Velg tastatur ekko som gnsket.
3. Velg OK knappen.
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Mus ekko leeser automatisk den tekst der ligger under musen pa skeermen. Nar musen
bevaeges hen over skeermen leeses enten ord eller linier op straks man peger med
musen eller efter lidt forsinkelse.

» For at aktivere Mus Ekko

ﬁ Klik pa Mus i Leeser veerktojslinien og veelg typen af mus ekko.

Mus

» For at justere Mus Ekko

1. Velg Mus Ekko... fra Leeser menuen.
2. Veelg mus ekko som ensket.
3. Veelg OK knappen.

38 ZoomText 9.1 kortvejledning



Detalje

Detaljeniveauet bestemmer hvor meget ekstra information, der skal laeses hojt nar man
bevaeger sig rundt i programmerne.

De tre niveauer — Begynder, Mellem og Ekspert — giver mulighed for hurtigt at skifte
niveau. Begynder niveauet giver mere information mens Ekspert giver mindre
information. Hvert niveau kan justeres sa de passer til ens behov.

» For at veelge detaljeniveau

Velg Detalje fra Laeser verktgjslinien og velg niveau.

é

Dekalie

» For at justere Detaljeniveau

1. Veelg Detaljeniveau... fra Leeser menuen.
2. Velg detaljeindstillingerne som onsket.
3. Velg OK knappen.
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AppReader

Programmet kaldet AppReader kan leese dokumenter, hjemmesider, og email hojt
mens man arbejder i det aktuelle program. Visningen pa skeermen sendres ikke nar
man starter eller stopper AppReader hvilket giver en hurtig og transparent made at
arbejde pa.

AppReader kan automatisk laese hele dokumenter hojt, eller man kan veelge at leese
teksten som ord, linier, seetninger eller afsnit. Nar leesningen er startet bliver hvert ord
markeret pa skeermen. AppReader indstillingerne giver mulighed for at veelge maden
markeringen skal vises pa, inklusiv form, farve, storrelse og om boksen skal veere
transparent.

» For at justere AppReader indstillingerne

1. Velg AppReader... fra Laeser menuen
2. Juster AppReader indstillingerne som onsket. IAcceSS to the Int
3. Veelg OK knappen.
applications and

been faster, easie

AppReader markering
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AppReader (fortsat)

» For at starte og bruge AppReader

2. Tryk pa AppReader genvejen: ALT + SKIFT + A,

@ 1. Aben et dokument en hjemmeside eller en email.
AppRdr ELLER AppRdr knappen pa ZoomTexts Laeser veerktojslinie.

AppReader begynder at leese fra tekstmarkerens position. Hois der ikke
findes en tekstmarker starter AppReader med at markere det forste ord
pd siden uden at opleesningen starter.
Bemark: AppReader knappen er deaktiveret (gra) nar det sidst
aktive program ikke har en leesbar tekst.

3. Tryk ENTER for at starte eller stoppe oplaesningen
ELLER klik med musen.

Ndr musen bruges kan man starte opleesningen fra den nye position
ved at klikke pd det ord der skal leeses.
4. Brug navigeringskommandoerne for AppReader (se "AppReader
og DocReader Genveje" pa side 56).
5. Hojreklik eller tryk ESC for at afslutte AppReader.

Nir AppReader afsluttes stir markeren pd det sidst leeste ord.

ZoomText 9.1 kortvejledning 41



Programmet kaldet DocReader kan leese dokumenter, hjemmesider, og email heijt.

Visningen pa skeermen afheenger af hvordan DocReader indstilles idet man kan veelge
anden skrifttype, andre farver end den der er brugt i den originale tekst. Man kan ogsa
bruge ordmarkering og anden forsterrelse end den der bruges pa den normale skaerm.

DocReader kan automatisk leese hele dokumenter hgijt, eller man kan veelge at leese
teksten som ord, linier, seetninger eller afsnit. Nar leesningen er startet bliver hvert ord
markeret pa skeermen.

Bl (=3x8 & B @ X B =33 & & B B X

Afspil Tempo Faktor Linie Side Indstil Tale Afslut Afspil Tempo Faktor Linie Side Indstil Tale Afslut
DocReader provides continuous reading of documents, web p DocReader provides ContinUOUS
Kl »

reading of documents, web pages
and email in a special

[YEFREEER provides continuous reading of enVIrOI']ment Where teXt |S

documents, web pages and email in a special . . .

e_nviljcmment w_hefegtext is r_efornjatted Eor easier refo rm a tte d fO r e a S | e r Vi er n g .
viewing. Text is presented in a ticker tape or . . R

tel‘epromptﬁrhformat, with your choice of fonts, Text |S p rese nted N a tl Cke r ta pe
colors, word highlighting, and magnification level. X

DocReader can automatically read through an or teleprompter fOFmat, Wlth your
ard lne, Samtence ot poracrah. Ak reading choice of fonts, colors, word

occurs, each spoken word is highlighted. h| a h || a ht| ng. a nd maan |f|Cat|On

Linie Side
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DocReader (fortsat)

» For at starte og bruge DocReader

2. Tryk pa DocReader genvejen: ALT + SKIFT + D,

E} 1. Aben et dokument en hjemmeside eller en email.
Dachdr ELLER DocRdr knappen pa ZoomTexts Laeser verktojslinie.

DocReader skaermen vises med teksten fra det originale dokument.
Huis den originale tekst vises med en aktiv marker vil ordet ved den
markeres i DocReader, ellers vil det forste ord i teksten markeres.
Bemark: DocReader knappen er deaktiveret (gra) nar det sidst
aktive program ikke har en leesbar tekst.

3. Tryk ENTER for at starte eller stoppe oplaesningen
ELLER klik med musen pa Afspil/Pause knappen.
Ndr musen bruges kan man starte oplaesningen fra den nye position ved
at klikke pd det ord der skal leeses.
4. Brug navigeringskommandoerne for DocReader (se "AppReader
og DocReader Genveje" pa side 56).
5. Hojreklik eller tryk ESC for at afslutte DocReader.

Nir DocReader afsluttes stiar markeren pd det sidst leeste ord.
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DocReader (fortsat)

DocReader veerktgjslinien giver mulighed for at styre opleesningen og visningen pa
skeermen.

»| |50 5 |3x3 @@ X

Afspil Tempo Faktor Linie Side Indstil Tale Afslut

DocReader veerktojslinien

Afspil/Pause Starter og stopper leesningen ved det markerede ord.
Hastighed  Styrer hvor hurtigt DocReader leeser — i ord per minut.

Faktor Indstiller forsterrelsen i DocReader mellem 1 gang og 36 gange

Linie Viser en enkelt linie tekst som ruller vandret over skeermen.
Samtidigt vises normal teksten nedenfor.

Side Viser teksten ombrudt sa den passer til skeermen.

Indstillinger Abner en dialogboks hvor man kan justere DocReader indstillingerne.

Tale Abner en dialogboks hvor man kan justere taleindstillingerne.

Afslut Afslutter DocReader og fokus vender tilbage til den originale tekst.
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Laesezoner

Laesezoner giver mulighed for hurtigt at laese tekst fra en forudbestemt position i et
program. ved brug af disse laesezoner kan man ved et tastetryk hurtigt laese indholdet
af udvalgte omrader i programmet man arbejder.

Man kan oprette op til 10 leesezoner for hvert program ZoomText segrger for
automatisk at indleese de leesezoner der er oprettet til det program man arbjder med.
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Laesezoner (fortsat)

Laesezone veerktgjslinien vises over den aktive leesezone sa snart man akitvere en
leesezone. Laesezonen giver mulighed for at laese og navigere i teksten.

1D KM X 1D X

Leesezone veerktojslinie: Leesezone veerktojslinie:
Rediger 0og naviger i zonetilstanden Aktiver tilstand

Afspil/Pause/Stop Starter og stopper opleesningen. Nar start oplaesning aktiveres
vil Pause og Stop knapperne blive vist. Pause knappen vises i Aktiv og Naviger
H H tilstanden hvor man kan pause og genstarte opleesningen ved det markerede ord.
Stop knappen vises i Rediger tilstanden hvor opleesningen altid genstarter fra det
i torste ord i zonen.
Genvej: ENTER
i 4 Forrige Aktiverer forrige laesezone.
Genvej: SKIFT + TAB
bi Naste Aktiverer naeste leesezone.
Genvej: TAB
% Luk Afslutter Leese zonetilstanden.
Genvej: ESC
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Laesezoner (fortsat)

» For at oprette en laesezone

1. Aben det program hvori der skal oprettes en zone. Kontroller at
Iﬂ den onskede del af programmetvises pa skeermen.
Fones 2. P& Laesning veerktejslinien veelges Zoner » Ny.Reading Zones
Genvej: CTRL + WIN + Z
Ny zone veerktojet aktiveres og alle eksisterende zoner for det aktive
program bliver synlige.
3. Flyt musen til den nye zone.
4. Hold den venstre museknap ned mens musen traekkes hen over det
onskede omrade og slip museknappen.
Ndir museknappen slippes vises leesezone dialogboksen. Her skal man

navngive zonen 0g indstille zoneegenskaberne. For mere information om
Leesezone dialogboksen se ”Leesezone indstillinger” i dette kapitel.

5. Skriv et navn pa zonen i Zonenavn feltet.

Ndr man navigere til den naeste element i dialogboksen vises navnet i
Zonelisten.
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Laesezoner (fortsat)

~

10.

Velg zonens relative position i programmet under Zonen er relativ til.
Veelg de onskede indstillinger under Zoneaktiviteter.
Tryk pa Aktiver for at teste den nye zone.

Laesezone dialogbioksen skjules kortvarrigt mens zonen vises og/eller laeses.

For at oprette nye zoner skal man velge Ny Zone og gentage trin 2 til 9.
Klik OK nar der ikke skal oprettes flere zoner.

48

ZoomText 9.1 kortvejledning



Laesezoner (fortsat)

» For at redigere en laesezone

1. Aben det program hvori der skal oprettes en zone. Kontroller at
Iﬂ den onskede del af programmetvises pa skeermen.
Pa Leesning veerktgjslinien veaelges Zoner » Rediger.Edit Reading
Genvej: CTRL + WIN + E
Rediger zone veerktojet vises 0g alle zoner for det aktive program bliver
synlige.

N

Zones

3. Flyt musen til den enskede zone eller klik pa Naeste eller Forrige
knapperne

4. Klik indenfor zonen for at aktivere justeringshandtagene og

veerktgjslinien.

Treek i zonens handtag for at justere storrelsen.

Traek indenfor zonen for at flytte den.

Klik pa Afspil knappen for at teste den nye indstilling.

Klik pa zonenummeret, Naeste eller Forrige knapperne for at flytte

® N oo

til en ny zone.
9. For at redigere en ny zoner skal man veelge gentage trin 4 til 8.
10. Hejreklik eller tryk ESC for at afslutte Rediger Zone veerktojet.
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Laesezoner (fortsat)

» For at aktivere en bestemt laesezone
Iﬂ 1. Aben det program hvortil zonen er oprettet.

2. Pa Laser verktojslinien veelges Zoner » Aktiver — veelg derefter
Fones den enskede zone.

Den valgte zone vises og/eller laeses som den er indstillet til.
Man kan ogsa aktivere en leesezone ved en af folgende mader:
e Tryk genvejen for Vis liste over Laesezoner: CTRL + WIN + L og
veelg zonen fra listen.

e Brug Naste og Forrige Lasezone genvejene:

To trigger... Press...

Aktiver zone 1 ... 10 CTRL+WIN+1..0
Naeste Laesezone CTRL + WIN + N
Forrige Laesezone CTRL + WIN + P
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Laesezoner (fortsat)

» For at navigere gennem alle laesezonerne
Iﬂ 1. Aben det program hvortil zonen er oprettet.

2. Pa Laser verktojslinien veelges Zoner » Naviger
FOnes Genvej: CTRL + WIN +V
Navigeringstilstanden aktiveres 0g Laesezone veerktojslinien vises over den
forste zone. Zonenavnet og nummeret laeses.
3. For at starte eller stoppe oplaesningen af zonen kan man klikke pa
Afspil/Pause knappen.

Bemark:  Afspil/Pause knappen er deaktiveret (grd) nar man
flytetr til en zone hvor opleesning er valgt fra.

4. For at navigere til en ny zone kan man klikke Naste eller Forrige
knapperne.

5. Klik pa Afslut, tryk ESC eller hojreklik for at afslutte
navigeringstilstanden.
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LaesDet vaerktojet

LaesDet veerktojet giver mulighed for at leese omrader pa skeermen ved at klikke med
bruge musen eller traekke et omrade ud omkring teksten. Al tekst pa skaermen kan
leeses med LaesDet veerktojet, ogsa selvom det ikke er i fokus.

Bemeerk: tekst der vises i grafiske billeder kan ikke laeses.

» For at bruge LaesDet vaerktgjet

1. Velg LasDet knappen fra Leaeser veerktojslinien
g] ELLER tryk pa LaesDet genvejen: ALT + SKIFT + |
Lasher 2. Klik pa et ord for at leese enkelte ord.
3. For at leese mere end et ord markeres teksten med musen.
Nir museknappen slippes laeses teksten hojt.

4. Hojreklik eller tryk ESC for at afslutte LaesDet veerktgijet.
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Tekstlaesning kommandoer

Kommandoerne til at leese tekstgiver mulighed for at navigere og laese mens der
arbejdes pa en tekst. Nar disse kommandoer bruges flyttes markoren sammen med
opleesningen. Nar man for eksempel bruger Laes naeste seetning kommandoen sa
flytter markeren til starten af seetningen og den laeses hojt. Felgende tabel viser en
oversigt over tekstleesning kommandoerne.

Bemeerk: Num Lock skal veere sldet fra nar man bruger kommandoer fra
regnetastaturet (num pad).

Tekstlaesning kommandoer Taster

Laes forrige tegn VENSTREPIL

Laes nuvaerende tegn NUMPAD 5

Laes naeste tegn H@IREPIL

Laes forrige ord CTRL + VENSTREPIL

Laes nuvaerende ord ++ CTRL + NUMPAD 5

Laes naeste ord CTRL + H@IREPIL

Laes forrige saetning CTRL + WIN + VENSTREPIL
Laes nuvaerende saetning CTRL + WIN + NUMPAD 5
Laes naeste saetning CTRL + WIN + H@JREPIL
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Tekstlaesning kommandoer (fortsat)

Tekstlaesning kommandoer Taster

Laes forrige linie ¢+« PILOP

Laes nuvaerende linie SKIFT + NUMPAD 5

Laes naeste linie ¢+ PILNED

Laes forrige afsnit CTRL + PILOP

Laes nuvaerende afsnit CTRL + SKIFT + NUMPAD 5
Laes naeste afsnit CTRL + PILNED

*  Anden gang man trykker Lees nuveerende kommandoen leeses tegnene med

navne ("Alpha, Bravo, Charlie...")

**  Gentagne tryk pa Laes nuveerende ord virker sadan:

o Forste tryk: leeser ordet

e Andet tryk: staver ordet

e Tredje tryk: staver ordet med navne ("Alpha, Bravo, Charlie...")
Bemeerk: gentagne tryk skal ske indenfor to sekunder.

*** Denne kommando leser ord eller linie atheengig af indstillingen for hvad

der skal leeses nar markeren bevaeges sig til ny linie.
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Genvejstaster er tastekombinationer der er knyttet til bestemte funktioner i ZoomText
sa man undgar at skulle abne ZoomText brugerfladen. Der findes genvejstaster til
neesten alle funktioner i ZoomText som gor at man kan kalde ZoomText funktioner
selvom et andet program er i fokus.

Nogle vigtige fakta om genvejstaster er:

e Man kan eendre eller deaktivere hver enkelt genvej for at undga konflikter med
andre programmer.

e Bade taster og museknapper kan bruges i en genve;.
e Hver genvej skal veere unik.

Hver genvej bestar af en eller flere kombinationstaster samt en primeer tast. En
kombinationstaster kan veere en af tasterne ALT, CTRL, SKIFT, CAPS LOCK eller
Windowstasten. Den primeere tast kan veere en vilkarlig anden tast eller mus-tast.

» To change hotkey settings

1. Velg Genveje... i Indstillinger menuen

Velg den gnskede Genvej Gruppe og Genvej Kommando.
Justér genvej indstillingen som gnsket.

Gentag trin 2 og 3 for hver genvej der skal eendres.

Klik pa OK knappen.

AR N
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AppReader og DocReader Genveje

Generelle kommandoer

Taster

Start AppReader

ALT + SKIFT + A

Start DocReader

ALT + SKIFT + D

Skift laesning (Afspil/Pause)

ENTER

Mere forstgrrelse

ALT + NUMPAD PLUS

Mindre forstgrrelse

ALT + NUMPAD MINUS

Stgrre talehastighed CTRL + NUMPAD PLUS
Lavere talehastighed CTRL + NUMPAD MINUS
Veer tavs CTRL
Afslut ESC
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AppReader og DocReader Genveje (7ortsat)

Navigeringskommandoer

Taster

Laes forrige ord

CTRL + VENSTREPIL, ELLER VENSTREPIL

Laes nuvaerende ord «

CTRL + NUMPAD 5, ELLER MELLEMRUM

Laes naeste ord

CTRL + H@IREPIL, ELLER H@JIREPIL

Laes ord over

PILOP

Laes ord under

PILNED

Laes forrige seetning

CTRL + WIN + VENSTREPIL

Laes nuvaerende saetning

CTRL + WIN + NUMPAD 5

Lees neaeste saetning

CTRL + WIN + H@IREPIL

Laes forrige afsnit

CTRL + PILOP

Laes nuvaerende afsnit

CTRL + SKIFT + NUMPAD 5

Laes naeste afsnit

CTRL + PILNED

Lees farste ord pa linien HOME

Laes sidste ord pa linien END

Side op PAGE UP
Side ned PAGE DOWN
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AppReader og DocReader Genveje (7ortsat)

Navigeringskommandoer (fortsat) Taster

Start pd dokumentet CTRL + HOME
Slut pa@ dokument CTRL + END
Naeste Link TAB

Forrige Link SKIFT + TAB
Falg Link CTRL + ENTER

L 4

e Forste tryk: leeser ordet
e Andet tryk: staver ordet

Gentagne tryk pa Lees nuveerende ord virker sddan:

e Tredje tryk: staver ordet med navne ("Alpha, Bravo, Charlie...")
Bemeerk: gentagne tryk skal ske indenfor to sekunder.
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Konfiguration Genvejstaster

Kommandoer Taster
Hent konfiguration 1...9 ALT + SKIFT +1 ...9

Windows Vista Logon Understgttelse Genveje

Kommandoer Taster

Logon Understgttelse Til ALT + INSERT

Logon Understgttelse Til ALT + DELETE

Forgg forstgrrelse ALT + NUMPAD PLUS
Formindsk forstgrrelse ALT + NUMPAD MINUS
Farve invertering Til/Fra CTRL + SKIFT + C
Tale Til/Fra ALT + SKIFT + S

Forstgrrelse Genveje

Kommandoer Taster
Mere forstgrrelse ALT + NUMPAD PLUS
Mindre forstgrrelse ALT + NUMPAD MINUS
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Forstgrrelse vaerktgjslinie Genveje

Kommandoer Taster

Vinduetype CTRL + SKIFT + Z
Juster vindue veerktgj CTRL + SKIFT + A
Ekstra Skaerm Til/Fra WINDOWS + SKIFT + D
Ekstra Skaerm visning WINDOWS + SKIFT + Z
Holdvaerktgj CTRL + SKIFT + N
Freeze Window On/Off CTRL + SKIFT + E
Farve fremhaever Til/Fra CTRL + SKIFT + C

Mus fremhaever Til/Fra CTRL + SKIFT + P
Markgr fremhaever Til/Fra CTRL + SKIFT + R
Fokus forbedringer Til/Fra CTRL + SKIFT + O
Tekstmarkgrfremhaevning type CTRL + SKIFT + F
Skrivebordssager CTRL + SKIFT + D

Web Sgger CTRL + SKIFT + W
Tekstmarkgrfremhaevning type CTRL + SKIFT + F
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Forskellige Genveje

Kommandoer Taster

Sgger Til/Fra CTRL + SKIFT + L
Feltvisning Til/Fra CTRL + SKIFT + V

Mus til skaerm CTRL + SKIFT + B
Skezerm til mus CTRL + SKIFT + Y

Lad passere (naeste ZoomText genvej) ALT + PAUSE

AHOI Til/Fra CTRL + ALT + SKIFT + A
AHOI Status CTRL + ALT + SKIFT + S
Kopier ZoomText skeerm CTRL + ALT + SKIFT + C
Find markgr CTRL + ALT + SKIFT + D
MSAA Til/Fra CTRL + ALT + SKIFT + M
Marker S@gning CTRL + ALT + SHIFT + H
Sporing Til/Fra CTRL + ALT + SKIFT + T
Opdater skeerm CTRL + ALT + SKIFT + U
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Laeser vaerktgjslinie Genveje

Kommandoer Taster

Tale Til/Fra ALT + SKIFT + S

Stgrre talehastighed CTRL + NUMPAD PLUS
Mindre talehastighed CTRL + NUMPAD MINUS
Tastatur ekko tilstand ALT + SKIFT + T

Mus ekko tilstand ALT + SKIFT + M
Detaljeniveau ALT + SKIFT + V

Start AppReader ALT + SKIFT + A

Start DocReader ALT + SKIFT + D
LaesDet veerktgj ALT + SKIFT + I
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Laesezone Genveje (kun for Magnifier/Reader)

Kommando Taster

Aktiver Zone 1 ... 10 CTRL+WIN+1...0
Naeste Laesezone CTRL + WIN + N
Forrige Laesezone CTRL + WIN + P

Vis liste over Laesezoner CTRL + WIN + L
Naviger blandt Laesezonerne CTRL + WIN + V

Ny Laesezone CTRL + WIN + Z
Rediger Laesezoner CTRL + WIN + E
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Skaermlaeser Genveje

Kommandoer

Taster

Laes vinduetitel

CTRL + WIN + W

Laes faneblad

CTRL+WIN + T

Laes beskedtekst

CTRL + WIN + M

Laes fokus

CTRL + WIN + F

Laes standardknap

CTRL + WIN + B

Laes gruppenavn

CTRL + WIN + G

Laes statuslinie

CTRL + WIN + X

Laes alt

CTRL + WIN + A

Laes markeret tekst

CTRL + WIN + S

Laes raekkeoverskrift

CTRL + WIN + R

Laes kolonneoverskrift

CTRL + WIN + K

Laes celleformel

CTRL + WIN + O

Laes cellekommentar

CTRL + WIN + C
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Skaermlaesning Genveje (ortsat)

Kommandoer

Taster

Laes nuveerende tidspunkt

CTRL + WIN + 1

Laes nuvaerende dato

CTRL + WIN +Y

Laes udklip ALT + SKIFT + C
Tavs ALT + SKIFT + Q, ELLER CTRL
Skift talesyntese ALT + SKIFT + E

Brugerflade Genveje

Kommandoer Taster
Aktiver ZoomText ALT + INS
Deaktiver ZoomText ALT + DEL

Vis brugerflade

CTRL + SKIFT + U

Hjeelpevaerktgj

CTRL + SKIFT + H
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Rulle Genveje

Kommandoer Taster

Rul op ALT + PILOP

Rul ned ALT + PILNED

Rul til venstre ALT + VENSTREPIL
Rul til hgjre ALT + H@IREPIL
Spring op ALT + PAGE UP
Spring ned ALT + PAGE DOWN
Spring til venstre ALT + HOME
Spring til hgjre ALT + END

Spring til centrum

ALT + NUMPAD 5

Gem skaerm

ALT + NUMPAD /

Gendan skaerm

ALT + NUMPAD *
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Konfigurationsfiler

Alle indstillingerne i ZoomText kan gemmes hen hentes frem efter behov.
Konfigurationsfilerne indeholder indstillingerne inklusiv forsterrelsen, typen af
zoomvindue, skeermfremhaevningerne, leeseindstillingerne og genvejene. Man kan
gemme sa mange konfigurationsfiler man har brug for.

» For at gemme en konfiguration
1. Indstil ZoomText som ensket.
2. Velg fra Filer menu funktionen Gem konfiguration...
Gem konfiguration dialogboksen vises, og man kan se de gemte konfigurationsfiler.

3. Skriv navnet pa filen i Filnavn: feltet.
4. Klik pa OK knappen.

» For at indlaese en konfigurationsfil

1. In the File menu, choose Open Configuration...
Aben konfiguration dialogboksen vises, og man kan se de gemte konfigurationsfiler.

2. Marker den gnskede konfigurationsfil.
3. Kilik pa OK knappen.
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Standardkonfigurationen

Nar man starter ZoomText vil standardindstillingerne fra filen med navnet ZT.ZXC
zxc blive indleest. Denne fil indeholder alle indbyggede standardindstillinger for
ZoomText. Man kan overskrive fabriksindstillingerne med sine egne og gendanne
tabriksindstillingerne hvis det bliver nadvendigt.

» For at gemme standardindstillingerne

1. Indstil ZoomText som ensket.
2. Velg fra Filer menuen funktionen Gem som standard.
3. Svar Ja for at overskrive den nuveerende standardindstilling.

» For at gendanne fabriksindstillingen for standarden

1. Veelg fra Filer menuen funktionen Gendan Standard.
2. Svar Ja for at overskrive den nuvaerende standardindstilling.
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Program indstillinger

For hver ZoomText konfiguration kan man definere specialindstillinger for hvert
program. Man kan for eksempel bruge forskellig forsterrelse til hjemmesider og til
tekstbehandling. Nar man har indstillet specielle programindstillinger vil ZoomText
automatisk indleese de indstillinger der passer til det program man arbejder i.

» For at oprette og gemme programindstillinger

1. Aben det program hvortil der skal oprettes nye ZoomText indstillinger.
2. Skift direkte til ZoomText og juster ZoomText som onsket til dette program.

3. Ga til Filer menuer og veelg Gem Programindstillinger.
En dialogboks sporger om programindstillingerne skal gemmes.

4. Klik pa Ja knappen for at gemme programindstillingerne.
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Program indstillinger (fortsat)

Man kan pa et vilkarligt tidspunkt deaktivere eller slette programindstillingerne.
Deaktiverede indstillinger bliver ikke slettet og kan genaktiveres nar man har brug
for det. Slettede indstillinger kan ikke hentes frem igen.

» For at deaktivere eller slette programindstillinger

1. Velg Juster Programindstillingerne... fra ZoomText Filer menuen

2. For at deaktivere programindstillinger; Under Brug programindstillinger for:
fjern markeringen ved den indstilling der skal deaktiveres.

3. For at slette programindstillinger skal man velge det enskede program og
klikke pa Slet valgte.

4. Klik pa OK knappen.
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ZoomText Scripting

ZoomText’s scripting funktion giver dig mulighed for at bruger-tilpasse, hvorledes
ZoomText og andre applikationer opferer sig, samt give mere informative visuelle og
audio tilbagemeldinger savel som automatisering af opgaver. Scripting gor det muligt
for dig at arbejde med forbedret hastighed og effektivitet.

Nogle af de mange ting, du kan gere med ZoomText scripting, er: automatisk
annoncere felter i en database eller pa et regneark, nye email, ny tekst, som kommer
til syne i et chat vindue, og mere meningsfyldt beskrivelse af applikation kontroller
og data.

For at leere mere om ZoomText Scripting se “ZoomText Scripting” i ZoomText online
hjeelpesystem.
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